Exercise 1

In this exercise we will determine the deflection of a beam which loaded at centre and fixed at both ends.

Pick File > Set Work Directory and set the work directory to the BeamSolid folder

E lﬁ Model Viewport View [nstar

_L New Model Database 3

B Open... Ctrl+0

Network ODB Connector >

M Close ODB..

!_% [Set Work Directory... |

E Save Ctrl+S
Save As...

Open the model database BeamFixed.cae. It will appear as shown below.

The model consists of a single part, Beam. The beam shown in above figure has a length of 300mm and
cross section of 50mm x 50mm. It is assumed to be made from Aluminum with a Young’s modulus of 70
GPa and a Poisson’s ratio of 0.3. It is meshed with 20-node quadratic brick elements with reduced
integration (C3D20R).

= Defining Step

We assume that load is applied slowly such that inertia effects can be neglected. So analysis will be
performed using the Static, General procedure.
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Change to Step module.
Module: |E Step ~  Model: |© FixedBeam -~ Step: : Initial [
[

11040

Pick *™™ to create a new step and select the Static, General step.

5 Create Step >

Mame:

Insert new step after

Procedure type: | General M

' Dynamic, Explicit L
Dynamic, Temp-disp, Explicit

Geostatic

Heat transzfer

Mass diffusion

Soils

| Static, Riks v

Pick Continue and Edit Step dialog box will appear. Notice that by default total time period is set to 1.0
and NLgeom option is set to Off.



5 Edit Step x
Mame: Step-1

Type: Static, General

Basic Incrementation Other

Description:

Tirne period: | 1
Kl @ﬂﬁﬁ (This setting controls the inclusion of nenlinear effects
g ' () on  of large displacements and affects subsequent steps.)

Automatic stabilization: | Mone e

We assume that changes in geometry are small during the loading of beam and a linear analysis will
provide accurate results. So we leave NLgeom option off.

Pick OK to complete the definition of step.

—> Defining Load

A concentrated force will be applied on a reference point which is coupled to the edge lying on the
midspan of the beam. The coupling has already been created by defining a “Coupling” constraint.

To define load, change to Load module.

 Load ~  Model: |2 FixedBeam [ Step:|:|r1itia| e

Module:

L (2
b B2

Pick == to create a load and select Step-1 in the Step field.

Select Concentrated in the Types field and pick Continue.
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S Create Load *
Mame: iLDEd-'I
Step: | 5tep-1 V

Procedure: Static, General

Category Types for Selected Step
Thermal Moment
Pressure

T Shell edge load
Surface traction
() Electrical/Magnetic Pipe pressure
ass diffusior Body force
() Other Line load
Gravity

Bolt load i

Continue... Cancel

Select the “RP” reference point as shown in figure below.

.L *
Y4 Pick this

Pick Done and enter -500000 as the force magnitude in y-direction.



- Type:

| & Edit Load

Mame: Load-1

Concentrated force

: Step: Step-1 (Static, General)

Region: (Picked) [3

| csys: (Global) [§ A

Distribution: | Unifarm

| CF1: 0

CF2: -500000
| CF=: 0
[ Amplitude: | (Ramp]

] Follow nodal rotation

(0] 4 Cancel

Pick OK and it completes the definition of load.

=) Boundary Conditions

Boundary conditions required for the analysis have already been defined. To review all the boundary

conditions pick = while the Load module is active as shown in the figure below.

~  Model: |© FixedBeam v Step:|:|nitia| 4

Module:

L |
E-}Q'

In the Boundary Conditions Manager it can be seen that two boundary conditions have already been
created. The boundary condition “BC-Right” constrains all the degree of freedom of right face of the beam.
The boundary condition “BC-Left” constrains all the degree of freedom of left face of the beam.

e

| Note: Forcewill be applied per node,

fix)

Pick Dismiss to close the manager.

“ Job Submission

All the information required for analysis has been set up in the model. Now we can submit the job for

analysis.
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So change to Job module and pick to open the job manager.

Module: ;égJob ~  Model: | FixedBeam ol Step: :-::Initial b
. |
Ta

Pick Create and create a job named CLoad Linear or whatever name you would like.

5 Create lob x

Mame: ;CLDad_Linear

Source: - Madel .v

Continue... Cancel

Pick Continue and then OK.

Pick Submit to submit the job for analysis.

% Job Manager >
' Name Maodel Type Status .

| CLoad Linear FixedBeam Full Analysis  Mone . .Data Check.

Submit |

: Create.. | Edit... .- Copy.. | Rename... DeFete...._ Dismiss |

Pick Results to view the results in Visualization module.



= o
=~ Postprocessing

Pick e, to plot contours on deformed shape.

Select U as output variable in the Field Output toolbar.

: 2?‘ Primary |5 EI Mises V'\:;‘\
' CF

M

E

o,
Pick &= to open Contour Plot Options dialog box and check the Show location field for Max limit as

shown below.

% Contour Plot Options >

Basic Color & Style Limits  Other

Mote: User-defined interval values override
the settings below.

Min,/ M ax
Max @ Auto-compute (0.0329849) |4 Show ocation!
(O Specify: |0.0329849

Min: @Auta-campute [ [] Show location
() Specify: |

Auto-Computed Limits
When auto-computing animaticn limits:

Uzse limits from all frames e

OK Apply Defaults Cancel

Pick OK to apply the changes and exit dialog box.

The simulation results will appear as shown below. (Deformation Scale factor is set to 1)
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U, Magnitude

+3.298e-02
[ +3.024-02

+2.749a-02
+2.474a-02
+2.199a-02
+1.9242-02
+1.649e-02
+1.374e-02
+1.099e-02
+8.2466-03
+5.4976-03
+2.749¢-03
+0.000e+00

Max: +3.298e-02
Node: BEAM-1.2

Max: +3.

98e-002

Abaqus 2017

It can be seen that midspan deflection is approximately 33mm which is approximately 11% of the beam’s
length. Remember that we did not turn on the NLgeom option which means that analysis did not take into
account the geometric nonlinearity in the structure. As we can see that deflection of the beam is
considerable, the assumption that large deformations will not take place does not seem correct. To verify if
this is the case, we will perform a geometrically nonlinear analysis.

= Performing Nonlinear Analysis

Change to Step module.

Open the Step Manager by picking

Pick the Step-1 and select Edit.

% Step Manager

MName
v Initial

Create...

Edit..

Procedure
(Initial)

i Static, General

Replace... |Rename...

Delete...

Nigeom Time

MSA M/A

Mlgeom... Dismiss

Turn on the Nlgeom option as shown below.



< Edit Step *
Mame: Step-1

Type: Static, General

Basic  Incrementation  Other

Description:

Tirne pericd: | 1

v O off (This setting controls the inclusion of nenlinear effects
g : @ iOn: | of large displacements and affects subsequent steps.)

Automatic stabilization: | Mone Pl

[ Include adiabatic heating effects

Under the Incrementation tab, set the initial increment size to 0.1

< Edit Step *

Mame: Step-1
Type: Static, General

Basic Incrementation  Other

Type: ®Automatic (O Fixed

Maximum number of increments: | 100

Initial Minimum  Maximum

Increment size: || 0.1 . 1E-005 . 1

In a nonlinear problem the solution is found by applying the load gradually and incrementally. Therefore
Abaqus breaks the simulation into a number of load incompetents. The ratio of the initial time increment to
the total time period specifies the proportion of load applied in the first increment.

Pick OK to apply the changes and exit the dialog box.

g . .
= Job Submission

All the information required for analysis has been set up in the model. Now we can submit the job for
analysis.

So change to Job module and pick = to open the job manager.

Pick Create and create a new job named CLoad NonLinear or whatever name you would like.



Solving Nonlinear Problems Abaqus 2017

Pick Continue and then OK.
Pick Submit to submit the job for analysis.

Pick Results to view the results in Visualization module.

= Postprocessing

Pick La, and select U as output variable in the Field Output toolbar.
The simulation results will appear as shown below.

U, Magnitude
+2.240e-02
+2.053e-02
+1.867e-02
+1.680e-02
+1.493e-02
+1.307e-02
+1.120e-02
+9.334e-03
+7.467e-03
+5.600e-03
+3.733e-03
+1.867e-03
+0.000e+00

Max: +2.240e-02
Node: BEAM-1.2

Max: +2.240e-002

It can be seen that midspan deflection is approximately 22.4mm which is considerably less than the
deflection with linear analysis. The difference between the linear and nonlinear simulations is sufficiently
large to conclude that a linear analysis is not appropriate for the beam and therefore a nonlinear analysis
must be performed to get realistic results.

As the load is applied, the shape of the beam changes to a curved shape and hence its stiffness also changes.

This change in shape and stiffness is accounted for in the nonlinear simulation. As a consequence of this,
simulation results are different for both analysis.

—> Job Monitoring

We will look at the information of analysis job by using Job Monitor.

Change to Job module and pick = to open the job manager.

Select CLoad_Linear job in the manager and pick Monitor and Job Monitor will appear as shown below.

10



&= Cload_Linear Monitor — O >

Job: Cload_Linear Status: Completed

Severe 2 .

: Equil Total Total Step Time/LPF
e | Mczement; | po | o | TmalEny | Tinedipe e
1 1 1 0 1 1 1 1 1

bt |
LDE Errors  !'Warnings Output DataFile MessageFile Status File
IStarteu:I: Analysis Input File Processor L
Completed: Analysis Input File Processor "
Search Text
Text to find: []Match case [l Next 1} Previous

Dismiss

The first column shows the step number and second column shows the number of increments. It can be
seen that job completes only in one increment as this is a linear analysis.

Select CLoad NonLinear job in the manager and pick Monitor and Job Monitor will appear as shown
below.

4= Cload_NonlLinear Manitor — O >

Job: Cload_Meonlinear Status: Completed

Severe = E
: Equil Total Total Step Time/LPF

Steg. | ImcrEmncol: | A0 DI;"E‘:“ Iter ler | Tine/Freq. | TimefLPF Inc

1 1 1 0 3 3 0.1 0.1 0.1

1 2 1 0 2 2 0.2 02 0.1

1 3 1 0 3 3 035 0.35 0.15

1 4 1 0 3 3 0,575 0.575 0.225

1 5 1 0 3 3 09125 09125 0.3375

1 6 1 0 2 2 1 1 0.0875

Log  Errors  !'Warnings Output Data File Message File  Status File

.A
Started: Analysis Input File Processor

W
Search Text
Text to find: [ []Match case L Next i} Previous

Dismiss

11
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It can be seen that total six increments are required to apply the full load. In the first increment, 10% of the
total load is applied, again 10% in the second, 15% in the third, 22.5% in the fourth, 33.75% in the fifth
and 8.75 % of the total load is applied in the sixth increment. Abaqus/Standard automatically controls the
increment size. It can also be seen that during the first increment, three iteration are required to converge to
a solution. During the second increment two iterations, during third,fourth and fifth increments three
iterations for each and during sixth increment two iteration are required to converge to a solution.

Select File > Save to save the changes we made so for.

12



Exercise 2

In this exercise we will analyze the beam shown schematically in the figure below.

f v v v Vv Vv vy

60mm

100mm

Pick File > Set Work Directory and set the work directory to the BeamPinned folder

Open the model database Beam.cae. It will appear as shown below.

Y

L.

The model consists of a single part, Beam. The beam shown in above figure has a length of 2m and hollow
cross section of 100mm x 60mm. The walls have a uniform thickness of Smm. It is modeled as one-
dimensional line (beam elements) instead of three-dimensional continuum elements. It is assumed to be
made from steel with a Young’s modulus of 200 GPa and a Poisson’s ratio of 0.3. It is meshed with 3-node
quadratic beam elements (B22). A uniform pressure of 40000 N/m is applied.

The following diagram shows the reactions at the supports computed using the analytical technique.

v v v Vv Vv vy

A A
40 kN 40 kN

pL*
EI

=0.0483

5
Deflection = —
/i 384

We will perform a finite element analysis and compare the results with analytical solution.
. Defining Step

We assume that load is applied slowly such that inertia effects can be neglected. So analysis will be
performed using the Static, General procedure.

Change to Step module.
13
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3 Step ~  Model: |+ Model-1 v Step: [+ Initial

Module;

=

e 2

11040

Pick * to create a new step and select the Static, General step.

Pick Continue and Edit Step dialog box will appear. Notice that by default total time period is set to 1.0
and NLgeom option is set to Off.

< Edit Step

Mame: Step-1
Type: Static, General

‘Basic | Incrementation  Other

Description:
Tirne period: | 1

@ off (This setting controls the inclusion of nonlinear effects

Nigeaire () On of large displacements and affects subsequent steps.)

Automatic stabilization: | Nane

[ Include adiabatic heating effects

We assume that changes in geometry are small during the loading of beam and a linear analysis will
provide accurate results. So we leave NLgeom option off.

Pick OK to complete the definition of step.

— Defining Load
A uniform pressure load will be applied across the top of the beam.

To define load, change to Load module.

Module: |+ Load ~ Model: [~ Model-1 v Step: |</Initial

L 2
b 2

14



Pick == to create a load and select Step-1 in the Step field.

Select Pressure in the Types field and pick Continue.

&% Create Load >
Mame: | Load-1
Step: | Step-1 @|
Procedure: Static, General
- Category i Types for Selected Sﬁp —
(® Mechanical Concentrated force -
i1 Thermal Moment
() Acoustic
- Shell edge load
) Fluid ;
Surface traction
() Electrical/Magnetic Pipe pressure
() Mass diffusion Body force
() Other Line load
Gravity
Bolt load "

Select the geometry of the beam as shown in figure below.

Pick Done to accept the selection.

Pick Magenta to specify the top side of the beam for applying pressure load.

Enter 40000 as the pressure magnitude.
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o= Edit Load o

Marme: Load-1

Type:  Pressure

Step: Step-1 (Static, General)

Region: (Picked) [3

Distribution: | Unifarm o fix)
Magnitude: |40000

Amplitude: | (Rarnp) e fﬁ'u

8] Cancel

Pick OK and it completes the definition of load.

= Boundary Conditions

Boundary conditions required for the analysis have already been defined. To review all the boundary

conditions pick = while the Load module is active as shown in the figure below.

- Load v Model:|- Model-1  ~| Step: |~ Step-1 v

Module:
N
e [E=
=

In the Boundary Conditions Manager it can be seen that two boundary conditions have already been
created.

The boundary condition “BC-Right” constrains translational degrees of freedom of right node of the beam.

The boundary condition “BC-Left” constrains translational degrees of freedom of left node of the beam.

Pick Dismiss to close the manager.

— Field Output Request

We will plot the section forces, i.e axial forces and shear forces. This information can be plotted by
requesting SF output variable.

16



SF variable contains all section forces and moment components.

Change to Step module.

Open the Field Output Manager by picking

Select the F-Output-1 field and pick Edit as shown below.

% Field Output Requests Manager x

Name Step-1 Edit...

Step procedure: Static, General

Variables: CDISP,CF,CSTATUS, CSTRESS, LE, PE,PEEC, PEMAG,RF,5,L...
Status: Created in this step
Create... Copy... . Rename... Delete... | " Dismiss |

Check the SF variable (located under the Forces/Reactions container).

Output Variables
(®) Select from list below () Precelected defaults () All () Edit variables

| 5,PE,PEEC, PEMAG, LE, U, RF,CF,5F, CSTRESS, CDISP

W [B| Forces/Reactions i
RF, Reaction forces and moments

] RT. Reaction forces

[ ] RM, Reacticn moments

_F, Concentrated forces and moments

[+’]'5F, Section forces and moments:
[] TF. Total forces and moments
[]VF, Viscous forces and moments due to static stabilization

[ ] ESF1, Effective axial force for beams and pipes subjected to pressure loading
Flrirmime— k1 10 r [ . ' "

< >

Mote: Some error indicators are not available when Domain is Whole Model or Interaction.

Pick OK to apply and exit.

Pick Dismiss to close the manager.

17
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'_'\ . .
= Job Submission

All the information required for analysis has been set up in the model. Now we can submit the job for
analysis.

So change to Job module and pick = to open the job manager.

*Job v Model:|- Model-1 ™| Step: i‘Step—“I ~

Module:

HIE
By B2

Pick Create and create a job named Pressure Linear or whatever name you would like.
Pick Continue and then OK.

Pick Submit to submit the job for analysis.

% Job Manager *
Mame Maodel Type Status Write Input
Pressure_Linear BeamPinned Full &nalysis Data Check
Submit
Maonitaor...
Results

Edit... Copy... Rename... Delete... Dismiss

Pick Results to view the results in Visualization module.

T .
= Postprocessing

Pick 3 and select U as output variable in the Field Output toolbar.

Hnu.
Pick = to open Contour Plot Options dialog box and check the Show location field for Max limit.

., bl ) )
Pick =32 and set the Deformation Scale Factor to Uniform and enter 3 as value.

18



Deformation Scale Factor
() Auto-compute (1)

@ iUniform: () Nenuniform
Yalue: | 3
O Apply

%+ Common Plot Options >
Basic Color & 5tyle Labels Mormals Other

Render Style Visible Edges

() Wireframe () Hidden Al edges

) Filled (®) Shaded (®) Exterior edges

() Feature edges
() Free edges
() Mo edges

."Q".

Defaults Cancel

The simulation results will appear as shown below.

U, Magnitude
+4.901e-02
+4.492e-02
+4.084e-02
+3.676e-02
+3.267e-02
+2.85%e-02
+2.450e-02
+2.042e-02
+1.634e-02
+1.225e-02
+8.168e-03
+4.084e-03
+0.000e+00

Max: : -

It can be seen that midspan deflection is approximately 49.01mm which is approximately 2.45% of the
beam’s length. Remember that we did not turn on the NLgeom option which means that analysis did not
take into account the geometric nonlinearity in the structure. We can say that deflection of the beam is

small as compared to the length of the beam.

Now we will plot the axial force in the beam.

Select SF as output variable in the Field Output toolbar and make sure that SF1 is selected as component.

H-ff‘-" Primary | 5F

14040

| SF1 M-S
SF2
SF6
SF3
SF4
SF5

19
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The simulation results will appear as shown below (Scale factor is set to 3).

SF, SF1

(Avg: 75%)
+3.976e-11
+3.457e-11
+2.937e-11
+2.418e-11
+1.899e-11
+1.380e-11
+8.608e-12
+3.416e-12
-1.775e-12
-6.967e-12 —
-1.216e-11
-1.735e-11
-2.254e-11

It can be seen that magnitude of the axial force is almost zero.

Now we will plot reaction forces at the end nodes where boundary conditions are defined.

Pick tt' and Create XY Data dialog box will appear.

Pick ODB field output > Continue

d% Create XY Data >

Source

(_)0DEB history output

(@ QDB field output
() Thickness

() Free body

() Operate on XY data
() ASCII file

() Keyboard

() Path

Continue... Cancel

In the Position field, select Unique Nodal and check the RF1 and RF2 checkboxes.

20
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S XV Data from ODE Field Qutput X
Steps/Frames

MNote: XY Data will be extracted from the active steps/frames Acti;.re.ﬁtepsfi:;ames...;

Variables  Elements/Modes
Cutput Variables

Position: | Unique MNodal v

Click checkboxes or edit the identifiers shown next to Edit below,

p [ ] BEAM STRESS: Linear Beamn Section Stress
P [ LE Logarithmic strain components

w [m] RF: Reaction force

[ | Magnitude

RF1
[« RF2

[] RM3: Reaction moment

In the Elements/Nodes tab, pick Node sets as method and select the SET-RIGHT. SET-RIGHT has been
predefined and contains the right end node of the beam.

S XY Data from ODE Field Qutput

Steps/Frames

Note: XV Data will be extracted from the active steps/frames | Active Steps/Frames...

Variables Elements/Modes

Selection

Method Name filter: o
Pick from viewport SET-LEFT

M s b

| ALL NODES

Internal sets

Pick Plot and the graph will appear as shown below.
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[x1.E3]
40.

— RF:RF1PI: BEAM-1 N: 21
——————— RF:RF2 PL: BEAM-1N: 21| -

35.
30.
25.
20.
15.
10.

5,

0 | 1 | L | 1 | L |

0.00 ' 0.20 0.40 0.60 0.80 1.00
Time

Force

L it i e e [liess pt i ik
| i [ |

It can be seen that the reaction force appear in y-direction (RF2) only and there is zero reaction force in the
x-direction (RF1). At the end of the step, when the load has been completely applied to the beam, reaction
force in y-direction reaches the magnitude of 40kN. This is the same solution as we obtained using
analytical technique.

The pressure loading which is always normal to the beam, starts to have a component in the x-direction as
the shape of the beam changes to a curved shape. This change in pressure direction is not accounted for in

a linear analysis. For comparison purposes, we will perform a geometrically nonlinear analysis and see if
geometric nonlinearities have a influence on the solution.

= Performing Nonlinear Analysis

Change to Step module.

Open the Step Manager by picking

Pick the Step-1 and select Edit.

% Step Manager >
Mame Procedure Nigeom Time
v Initial (Initial) MSA M/A

- Static, General

Create... Edit... Replace... Rename... Delete... Mlgeom... Dismiss

Turn on the Nlgeom option as shown below.
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< Edit Step *
Mame: Step-1

Type: Static, General

Basic  Incrementation  Other

Description:

Tirne pericd: | 1

v O off (This setting controls the inclusion of nenlinear effects
g : @ iOn: | of large displacements and affects subsequent steps.)

Automatic stabilization: | Mone Pl

[ Include adiabatic heating effects

Under the Incrementation tab, set the initial increment size to 0.1

% Edit Step =
Mame: Step-1
Type: Static, General

Basic Incrementation  Other

Type: (@ Automatic () Fixed

Maximum number of increments: | 100
Initial Minimum  Maximum

Increment size: || 0.1 . 1E-005 . 1

In a nonlinear problem the solution is found by applying the load gradually and incrementally. Therefore
Abaqus breaks the simulation into a number of load incompetents. The ratio of the initial time increment to
the total time period specifies the proportion of load applied in the first increment.

Pick OK to apply the changes and exit the dialog box.

g . .
= Job Submission

All the information required for analysis has been set up. Now we can submit the job for analysis.

So change to Job module and pick = to open the job manager.
Pick Create and create a new job named Pressure NonLinear or whatever name you would like.

Pick Continue and then OK.
23
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Pick Submit to submit the job for analysis.

Pick Results to view the results in Visualization module.

~~ Postprocessing

Pick 3 and select U as output variable in the Field Output toolbar.
The simulation results will appear as shown below (Scale factor is set to 3).

U, Magnitude

+3.299-02
[ +3.024e-02
+2.749¢-02
+2.4756-02
+2.200e-02
+1.9256-02
+1.650e-02
+1.3756-02
+1.100e-02
+8.248e-03 —

L +5.499e-03 _ -
I +2.749e-03 Max: +3.299e-002
+0.000e+00

It can be seen that midspan deflection is approximately 32.9mm which is significantly less than the
deflection with linear analysis.

As the load is applied, the shape of the beam changes to a curved shape and hence its stiffness also changes.
This change in shape and stiffness is accounted for in the nonlinear simulation. Furthermore, the pressure
loading which is always normal to the beam, starts to have a component in the x-direction as the beam
bends. In a nonlinear analysis, normals to boundaries are updated and pressure load take the deformation
into account. As a consequence of this, simulation results are different for the linear and nonlinear analysis.

Now we will plot the axial force in the beam.
Select SF as output variable in the Field Output toolbar and make sure that SF1 is selected as component.
The simulation results will appear as shown below (Scale factor is set to 3).

SF, SF1
(Avg: 75%)
+2.040e+05
+2.040e405
+2.039e+05
+2.039e+05
+2.038e+05
+2.038e4+05
+2.037e+05
+2.037e+05
+2.036e405
+2.036e+05 = ——
+2.035e+05
+2.035e+05
+2.035e+05
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It can be seen that a significant axial force has developed in the beam, similar to a wire in tension. Initially
the beam resists the pressure load with bending stiffness but after the pressure causes the beam to be
curved, the deformed geometry exhibits additional stiffness and axial forces appear in the beam.
Membrane effects cause some of the load to be carried by axial forces rather than by bending alone.

As the load increases on beam there will be membrane forces in addition to bending moments.

Now we will plot reaction forces at the end nodes where boundary conditions are defined.

Pick Eﬂ and Create XY Data dialog box will appear.
Pick ODB field output > Continue
In the Position field, select Unique Nodal and check the RF1 and RF2 checkboxes.

In the Elements/Nodes tab, pick Node sets as method and select the SET-RIGHT. SET-RIGHT has been
predefined and contains the right node of the beam.

S XY Data from ODE Field Qutput o

Steps/Frames

Note: XV Data will be extracted from the active steps/frames Active Steps/Frames...

Variables Elements/Modes

Selection

Method Name filter 5
Pick from viewport SET-LEFT

o s S S
Nodesets _____[IIFYNYGLTS

Internal sets

Pick Plot and the graph will appear as shown below.

[x1.E3]
200.F T 1 T T T T T I T
r | —— RF:RF2 PI: BEAM-1 N: 21 ]
160, |-~ RF:RF1 PI: BEAM-1 N: 21 e
o 120.F |
=
5 L |
80.F -
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It can be seen that reaction forces also develop in the x-direction. This could be related to the presence of
axial forces in the beam.

Although the deflection of the beam’s middle point is small compared to the overall dimension of the beam
but still geometric nonlinearity has significant influence on the final solution as compared to the linear

solution.

It can be said that boundary conditions have significant influence on the membrane forces in the beam.
These membrane forces make the structure stiffer which affects the deflection of the structure significantly.

Select File > Save to save the changes we made so for.
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Exercise 3

In this exercise we will analyze the beam shown schematically in the figure below.

f v v v Vv Vv vy

60mm

100mm

Pick File > Set Work Directory and set the work directory to the BeamPinnedRoller folder

Open the model database BeamPR.cae. It will appear as shown below.

Y

L.

The model consists of a single part, Beam. The beam shown in above figure has a length of 2m and hollow
cross section of 100mm x 60mm. It is modeled as one-dimensional line (beam elements) instead of three-
dimensional continuum elements. It is assumed to be made from steel with a Young’s modulus of 200 GPa
and a Poisson’s ratio of 0.3. It is meshed with 3-node quadratic beam elements (B22). A uniform pressure
of' 40000 N/m is applied.

The following diagram shows the reactions at the supports computed using the analytical technique.

v v v Vv Vv vy

A A
40 kN 40 kN

pL*
EI

=0.0483

5
Deflection = —
/i 384

We will perform a finite element analysis and compare the results with analytical solution.
. Defining Step

We assume that load is applied slowly such that inertia effects can be neglected. So analysis will be
performed using the Static, General procedure.

Change to Step module.
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Pick *™™ to create a new step and select the Static, General step.

Pick Continue and Edit Step dialog box will appear. Notice that by default total time period is set to 1.0
and NLgeom option is set to Off.

< Edit Step x

Marme: Step-1
Type: Static, General

‘Basic | Incrementation  Other
Description:
Tirne period: |1

® Off (This setting contraols the inclusion of nenlinear effects

Nigearm () on of large displacements and affects subsequent steps.)

Automatic stabilization: | None P

[] Include adiabatic heating effects

We assume that changes in geometry are small during the loading of beam and a linear analysis will
provide accurate results. So we leave NLgeom option off.

Pick OK to complete the definition of step.

= Defining Load
A uniform pressure load will be applied across the top of the beam.

To define load, change to Load module.

Module: |+ Load ~ Model: [~ Model-1 v Step: |</Initial M
L 2
b (2

Pick =5 to create a load and select Step-1 in the Step field.

Select Pressure in the Types field and pick Continue.
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&= Create Load x
Mame: Load-1
Step: Step—"t @|
Procedure: 5tatic, General
— Category i Types for Selected Sﬁp =—
(®) Mechanical Concentrated force ”
() Thermal Moment
() Acoustic Bt
- Shell edge load
O Fluid :
Surface traction
() Electrical/Magnetic Pipe pressure
() Mass diffusion Body force
D Other Line load
Gravity
Bolt load W

Select the geometry of the beam as shown in figure below.

Pick Done to accept the selection.

Pick Magenta to specify the top side of the beam for applying pressure load.

Enter 40000 as the pressure magnitude.
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o= Edit Load o

Marme: Load-1

Type:  Pressure

Step: Step-1 (Static, General)

Region: (Picked) [3

Distribution: | Unifarm o fix)
Magnitude: |40000

Amplitude: | (Rarnp) e fﬁ'u

8] Cancel

Pick OK and it completes the definition of load.

= Boundary Conditions

Boundary conditions required for the analysis have already been defined. To review all the boundary

conditions pick = while the Load module is active as shown in the figure below.

- Load v Model:|- Model-1  ~| Step: |~ Step-1 v

Module:
N
e [E=
=

In the Boundary Conditions Manager it can be seen that two boundary conditions have already been
created. The boundary condition “BC-Right” constrains translational degree of freedom of right end of the
beam along y-axis. The boundary condition “BC-Left” constrains all translational degrees of freedom of
left end of the beam.

Pick Dismiss to close the manager.

— Field Output Request

We will plot the section forces, i.e axial forces and shear forces. This information can be plotted by
requesting SF output variable.

SF variable contains all section forces and moment components.
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Change to Step module.

Open the Field Output Manager by picking

Select the F-Output-1 field and pick Edit as shown below.

% Field Output Requests Manager x

Name Step-1 Edit...

Step procedure: Static, General

Variables: CDISP,CF,CSTATUS, CSTRESS, LE, PE,PEEC, PEMAG,RF,5,L...
Status: Created in this step
Create... Copy... Rename... Delete... Dismiss

Check the SF variable (located under the Forces/Reactions container).

W [H] Forces/Reactions

RF, Reaction forces and moments

[ ] RT, Reacticn forces

[]RM, Reacticn mements

CF, Concentrated forces and moments
[]i5F, Section forces and moments
[ ] TF. Total forces and moments

[ ] VF. Viscous forces and moments due to static stabilization

[ ] ESF1, Effective axial force for beams and pipes subjected to pressure loading

Pick OK to apply and exit.

Pick Dismiss to close the manager.

= o o
= Job Submission

All the information required for analysis has been set up in the model. Now we can submit the job for
analysis.

So change to Job module and pick = to open the job manager.
Pick Create and create a job named Pressure Linear or whatever name you would like.

Pick Continue and then OK.
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Pick Submit to submit the job for analysis.

Pick Results to view the results in Visualization module.

~~ Postprocessing

Pick 3 and select U as output variable in the Field Output toolbar.

4.
Pick = to open Contour Plot Options dialog box and check the Show location field for Max limit.

The simulation results will appear as shown below (Scale factor is set to 3).

U, Magnitude
+4.901e-02
+4.492e-02
+4.084e-02
+3.676e-02
+3.267e-02
+2.859e-02
+2.450e-02
+2.042e-02
+1.634e-02 e —
+1.225e-02
+8.168e-03 ——— -
+4.084e-03 Max: +4.901e-002
+0.000e+00

It can be seen that midspan deflection is approximately 49.01mm which is approximately 2.45% of the
beam’s length. Remember that we did not turn on the NLgeom option which means that analysis did not
take into account the geometric nonlinearity in the structure. We can say that deflection of the beam is
small as compared to the length of the beam.

Now we will plot the axial force in the beam.

Select SF as output variable in the Field Output toolbar and make sure that SF1 is selected as component.

Field Qutput [ |

Bsa primary | SF | SF1 S

110 40

The simulation results will appear as shown below (Scale factor is set to 3).

SF, SF1
(Avg: 75%)

+3.976e-11

+3.457e-11

+2.937e-11

+2.418e-11

+1.899e-11

+1.380e-11

148.608e-12

1+3.416e-12

-1.775e-12

L -6.967e-12 ===
-1.216e-11 -
-1.735e-11

-2.254e-11
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It can be seen that magnitude of the axial force is almost zero.

Now we will plot reaction forces at the end nodes where boundary conditions are defined.

Pick Eﬂ and Create XY Data dialog box will appear.

Pick ODB field output > Continue

o= Create XY Data >

Source

(Z):0DB history output
| ® ODE field output

() Thickness

(") Free body

In the Position field, select Unique Nodal and check the RF1 and RF2 checkboxes.

S XV Data from ODE Field Qutput X
Steps/Frames

MNote: XY Data will be extracted from the active steps/frames Active Steps/Frames...

Wariables  Elements/Modes

Cutput Variables

Position: | Unique Nodal ot

Click checkboxes or edit the identifiers shown next to Edit below,

p [ ] BEAM STRESS: Linear Beamn Section Stress
P [ LE Logarithmic strain components

w [m] RF: Reaction force
[ | Magnitude

RF1
RF2

[] RM3: Reaction moment

In the Elements/Nodes tab, pick Node sets as method and select the SET-RIGHT. SET-RIGHT has been
predefined and contains the right end node of the beam.
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S XY Data from ODE Field Qutput

Steps/Frames

MNote: XY Data will be extracted fro

Variables Elements/Modes
Selection
Method

Pick from viewport
Mode labels

Internal sets

m the active steps/frames Active Steps/Frames...

Mame filter: :Qt

SET-LEFT

SETRIGHT
ALL MODES

Pick Plot and the graph will appear as shown below.

[x1.E3]
40.

35.
30.
25.
20.
15.
10.
5,
0

Force

L] e [ [ ] A s U ik |

— 'RF:RF1 PI: BEAM-1 N: 21
------- RF:RF2 PI: BEAM-1 N: 21

| i [ |

0.00

0.20 0.40 0.60 0.80 1.00
Time

It can be seen that the reaction force appear in y-direction (RF2) only and there is zero reaction force in the
x-direction (RF1). At the end of the step, when the load has been completely applied to the beam, reaction
force in y-direction reaches the magnitude of 40kN. By comparing the reaction force and deflection of
midspan to the values obtained from analytical solution it can be said that linear solution and analytical

solution are similar.

The pressure loading which is always normal to the beam, starts to have a component in the x-direction as
the shape of the beam changes to a curved shape. This change in pressure direction is not accounted for in
a linear analysis. For comparison purposes, we will perform a geometrically nonlinear analysis and see if
geometric nonlinearities have a influence on the solution.

=5 Performing Nonlinear Analysis

Change to Step module.
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Open the Step Manager by picking

Pick the Step-1 and select Edit.

S Step Manager >
Name Procedure Nigeom Time
v Initial (Initial) N/A MSA

: Static, General

.Create... Edit... 1 .RepLace.... E-Eename....: | Delete... ] ;Nfgeum...' Disrniss

Turn on the Nlgeom option as shown below.

< Edit Step X
Mame: Step-1
Type: Static, General

Basic  Incrementation  Other

Description: I

Tirne pericd: (1

O off (This setting controls the inclusion of nenlinear effects

Mlgeom: (@ i0n | of large displacements and affects subsequent steps.)

Automatic stabilization: | None et

[ Include adiabatic heating effects

Under the Incrementation tab, set the initial increment size to 0.1

< Edit Step *

Mame: Step-1
Type: Static, General

Basic Incrementation  Other

................ &

Type: @ Automatic O Fixed

Maximum number of increments: . 100

Initial Minimum  Maximum

Increment size: ;'I].'F .I'iE;'DEISI 1
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In a nonlinear problem the solution is found by applying the load gradually and incrementally. Therefore
Abaqus breaks the simulation into a number of load incompetents. The ratio of the initial time increment to
the total time period specifies the proportion of load applied in the first increment.

Pick OK to apply the changes and exit the dialog box.

“— Job Submission

All the information required for analysis has been set up. Now we can submit the job for analysis.

So change to Job module and pick = to open the job manager.

Pick Create and create a new job named Pressure NonLinear or whatever name you would like.
Pick Continue and then OK.

Pick Submit to submit the job for analysis.

Pick Results to view the results in Visualization module.

~—~ Postprocessing

Pick £3 and select U as output variable in the Field Output toolbar.
The simulation results will appear as shown below (Scale factor is set to 3).

U, Magnitude

+4.8746-02
E +4.4686-02
+4.0626-02
+3.6568-02
+3.250e-02
+2.843e-02
+2.4378-02
+2.031e-02
+16256-02 @ ~— ——

+1.219e-02

+8.124e-03 = : =

+4.062a-03 Max: +4.874e-002
+0.000e+4-00

It can be seen that midspan deflection is approximately 48.7mm which is approximately equal to the
deflection with linear analysis. As compared to the previous exercise where right end was pinned, this is a
big change. It could be attributed to the free movement of right end along x-axis as compared to the
previous exercise.

Now we will plot the axial force in the beam.

Select SF as output variable in the Field Output toolbar and make sure that SF1 is selected as component.
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The simulation results will appear as shown below (Scale factor is set to 3).

SF, SF1
(Avg: 75%)

+3.093e+03
[ +2.9966403
+2.899+03
+2.8026+03
+2.7056+03
+2.608e+03
+2.511e+03
+2.414e+03
+2.317e+03 ~—— e

+2.220e+03
[ +2.1236403 -

+2.026e+03
+1.92%e+03

It can be seen that an axial force has developed in the beam, but this force is significantly lower than the
case for pinned boundary condition as seen in the previous exercise. We can say that due to the freedom of
the right end to move along x-axis the axial force (tension) is not as high as for the case when both ends are

pinned.

Now we will plot reaction forces at the end nodes where boundary conditions are defined.

Pick Ej and Create XY Data dialog box will appear.
Pick ODB field output > Continue
In the Position field, select Unique Nodal and check the RF1 and RF2 checkboxes.

In the Elements/Nodes tab, pick Node sets as method and select the SET-RIGHT. SET-RIGHT has been
predefined and contains the right node of the beam.

S XY Data from ODE Field Qutput o

Steps/Frames

Note: XV Data will be extracted from the active steps/frames Active Steps/Frames...

Variables Elements/Modes
Selection

Method Name filter: o

Pick from viewport SET-LEFT
Mode labels |

Internal sets

Pick Plot and the graph will appear as shown below.
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[x1.E3]

40 F T "RF:RF1 PI: BEAM-1 N: 21
35. RF:RF2 PI: BEAM-1 N: 21 A
30. ]
25.
20.

15.

Force

L it i e e [liess pt i ik
| i [ |

Time

It can be seen that reaction forces do not develop in the x-direction due to roller boundary condition. A
similar graph is obtained if the reaction forces are plotted on the left end of the beam.

It can be concluded that nonlinear analysis is essential to take into account the membrane forces in a
structure. By comparing the results with previous exercise, it can also be said the membrane forces depend

greatly on the boundary conditions

Select File > Save to save the changes we made so for.
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Exercise 4

In this exercise we will analyze a plate shown schematically in the figure below under the loading of a
uniform pressure.

Pick File > Set Work Directory and set the work directory to the PlateBending folder

Open the model database Plate.cae. It will appear as shown below.

The model consists of a single part, Plate. The plate shown in above figure has a length of 1.0m, a width of
0.3m and thickness is 6mm. It has a thickness-to-minimum span ratio of 0.02 (0.006/0.3) and hence
considered thin. It is assumed to be made from aluminum with a Young’s modulus of 70GPa and a
Poisson’s ratio of 0.3. The plate is modeled using planar shell feature. We assume that strains will be small.
So it is meshed with quadratic shell elements with reduced integration (S8RS5). The plate is loaded with a

uniform pressure of 20 kPa.

= Defining Step
We assume that load is applied slowly such that inertia effects can be neglected. So analysis will be
performed using the Static, General procedure.

Change to Step module.

Mmduleriir%sfcep . Model:lé;MDdel—T ,U‘ Step: |= Initial IL[

i
4 i

o:a (5
4= B2

11040

Pick **™ to create a new step and select the Static, General step.
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Pick Continue and Edit Step dialog box will appear. Notice that by default total time period is set to 1.0
and NLgeom option is set to Off.

< Edit Step

Mame: Step-1
Type: Static, General

¢ Incrementation  Other

Description:

Tirne period: | 1

A Off  (This setting controls the inclusion of nonlinear effects
g : () On of large displacements and affects subsequent steps.)

Automatic stabilization: | Nane

[ Include adiabatic heating effects

We assume that changes in geometry are small during the loading and a linear analysis will provide

accurate results. So we leave NLgeom option off.

Pick OK to complete the definition of step.

— Defining Load
A uniform pressure load will be applied across the top of the plate.

To define load, change to Load module.

o

Module: [* Load ¥ Model: |~ Model-1 v Step: |< Initial

L 72
b B

Pick == to create a load and select Step-1 in the Step field.

Select Pressure in the Types field and pick Continue.
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&= Create Load x

Mame: | Load-1

Step: | Step-1 et

Procedure: 5tatic, General

Category Types for Selected Step
(® Mechanical Concentrated force ~
Thermal Moment

Shell edge load

Surface traction

Fluid

(O Electrical/Magnetic Pipe pressure

Mass diffusion Body force
() Other Line load
Gravity
Bolt load W

Continue...

Select the surface of the plate as shown in figure below.

Pick Done to accept the selection.

Pick Brown to specify the top side of the plate for applying pressure load.

Enter 20000 as the pressure magnitude.
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| % Edit Load X
Mame: Load-1 -
. Type:  Pressure

| Step: Step-1 (Static, General)

Region: (Picked) [3

Distribution: | Uniform W fix)
Magnitude: | 20000

| Amplitude: | (Ramp] i n.-f

0] Cancel

Pick OK and it completes the definition of load.

= Boundary Conditions

Abaqus 2017

Boundary conditions required for the analysis have already been defined. To review all the boundary

conditions pick = while the Load module is active as shown in the figure below.

- Load ¥ Model:|- Model-1  ~ Step:|~ Step-1

Module:

)

=
[ [

b= LS

In the Boundary Conditions Manager it can be seen that two boundary conditions have already been
created. The boundary condition “BC-Right” constrains all translational and rotational degrees of freedom
of right edge of the plate except the translation in x-direction. The boundary condition “BC-Left”

constrains all degrees of freedom of left edge of the plate.

Pick Dismiss to close the manager.

— Field Output Request

We will plot the section forces, i.e membrane forces and shear forces. This information can be plotted by

requesting SF output variable.
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SF variable contains all section forces and moment components.

Change to Step module.

Open the Field Output Manager by picking

Select the F-Output-1 field and pick Edit as shown below.

% Field Output Requests Manager x

Name Step-1

Step procedure: Static, General

Variables: Preselected defaults
Status: Created in this step
Create... Copy... Rename... Delete... Dismniss

Check the SF variable (located under the Forces/Reactions container).

Output Variables
(®) Select from list below () Preselected defaults () All () Edit variables

' 5,PE,PEEQ,PEMAG, LE, U, RF, CF,5F, CSTRESS, CDISP

w [§] Forces/Reactions o)
RF, Reaction forces and moments

[] RT, Reaction forces

[] RM, Reaction moments

CF, Concentrated forces and moments

[]iSF, Section forces and moments
] TF, Total forces and moments

[ ] VF. Viscous forces and moments due to static stabilization

[ ] ESF1, Effective axial force for beams and pipes subjected to pressure loading
M 1 eirevmas k1 LI L) " 1 ] v

£ >

Mote: Some error indicators are not available when Domain is Whole Model or Interaction.

Pick OK to apply and exit.

Pick Dismiss to close the manager.
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'_'\ . .
= Job Submission

All the information required for analysis has been set up in the model. Now we can submit the job for
analysis.

So change to Job module and pick = to open the job manager.

Module:

L A=
By B2

% Job v Model: |- Model-1  ~ Step: t‘Step—'I g

Pick Create and create a job named Pressure Linear or whatever name you would like.
Pick Continue and then OK.

Pick Submit to submit the job for analysis.

5 Job Manager >
Name Model Type Status
Pressure_Linear Model-1 Full Analysis Completed Data Check
Subrmit
Maonitor...
Results
Create... Edit... Copy... Rename... Delete... Disrmniss

Pick Results to view the results in Visualization module.

=L A
= Postprocessing

Pick La, and select U as output variable in the Field Output toolbar.

Pick U3 in the component field.

o,
Pick = to open Contour Plot Options dialog box and check the Show location field for Min limit.

The simulation results will appear as shown below (Scale factor is set to 2).
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U, U3

+0.000e+00
E -3.363e-03
-6.7276-03
-1.009e-02
-1.345a-02
-1.682e-02
-2.018e-02
-2.3546-02
-2.691e-02
-3.027e-02
-3.363e-02
-3.700e-02
-4.036e-02

It can be seen that midspan deflection is about 40.4mm which is approximately 4% of the plates’s length.
Remember that we did not turn on the NLgeom option which means that analysis did not take into account
the geometric nonlinearity in the structure. We can say that deflection of the plate is small as compared to
the length of the plate.

Now we will plot the membrane force in the plate.

Select SF as output variable in the Field Output toolbar and make sure that SF1 is selected as component.

‘Bt primary | SF

19040

5F2
SF&
SF3
5F4
SF5

The simulation results will appear as shown below (Scale factor is set to 2).

SF, SF1
(Avg: 75%)

+1.069e-10
E +8.731e-11

I 16.76%e-11
+4.807e-11
+2.845e-11
+8.835e-12
-1.078e-11
-3.040e-11
-5.002e-11
-6.964e-11
-8.926e-11
-1.089%-10
-1.285e-10

It can be seen that magnitude of the membrane force is almost zero. It is expected as the applied pressure
acts in the z-direction.

Now we will plot reaction forces at the end nodes where boundary conditions are defined.

Select Symbol as category in the Field Output toolbar.
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Hﬁﬁ Primary EI U ~|| Magnitude ~ \‘;\

11040

Primary
Deformed

Select RF as output variable and make sure that RESULTANT is selected in component field.

Bl Symbol || U M resuLTanT &

RF
RM
5
5F
5M
u
UR

The simulation results will appear as shown below (Scale factor is set to 2).

RF, Resultant

+4.62%e+02
+4.243e+02
+3.857e+02
+3.471e+02
+3.086e+02
+2.700e+02
+2.314e+02 Z
+1.929%e+02

+1.543e+02

+1.157e+02 I
+7.714e+01 X
+3.857e+01

+0.000e+00

It can be seen that the reaction force appear in z-direction (RF3) only and there is zero reaction force in the
x and y-directions (It can be confirmed by plotting RF1 and RF2 components).

The pressure loading which is always normal to the plate, starts to have a component in the x-direction as
the plate changes to a curved shape. This change in pressure direction is not accounted for in a linear

analysis. For comparison purposes, we will perform a geometrically nonlinear analysis and see if
geometric nonlinearities have a influence on the solution.

= Performing Nonlinear Analysis

Change to Step module.

Open the Step Manager by picking

Pick the Step-1 and select Edit.
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S Step Manager >

Name Procedure Nigeom Time
v Initial (Initial) MSA MiA

i Static, General

Create... Edit.. | Replace... ‘Rename...| Delete... ;Nfgeom... Disrniss

Turn on the Nlgeom option as shown below.

< Edit Step X,
Marme: Step-1
Type: Static, General

Basic  |ncrementation  Other

Description: .
Time period: | 1
Fliaa O off (This setting controls the inclusion of nonlinear effects
g : @ i0n | of large displacements and affects subsequent steps.)
Automatic stabilization: | Mone "v'

[ Include adiabatic heating effects

Under the Incrementation tab, set the initial increment size to 0.1

< Edit Step *

Mame: Step-1
Type: Static, General

Basic Incrementation  Other

Maximum number of increments: . 100

Initial Minimum  Maximum

Increment size: || 0.1 i 1E-m5 . . 1

In a nonlinear problem the solution is found by applying the load gradually and incrementally. Therefore
Abaqus breaks the simulation into a number of load incompetents. The ratio of the initial time increment to
the total time period specifies the proportion of load applied in the first increment.
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Pick OK to apply the changes and exit the dialog box.

'_'\ . .
= Job Submission

Now we can submit the job for analysis.

So change to Job module and pick = to open the job manager.

Pick Create and create a new job named Pressure NonLinear or whatever name you would like.
Pick Continue and then OK.

Pick Submit to submit the job for analysis.

Pick Results to view the results in Visualization module.

=L A
= Postprocessing

Pick £3 and select U as output variable in the Field Output toolbar.

Pick U3 in the component field.

4.
Pick = to open Contour Plot Options dialog box and check the Show location field for Min limit.

The simulation results will appear as shown below (Scale factor is set to 2).

U, U3

+0.000e+00
[ -3.219e-03
-6.4386-03
-9.6576-03
-1.2886-02
-1.609e-02
-1.9316-02
-2.253¢-02
-2.5756-02

-2.897e-02
-3.21%e-02
-3.541e-02

-3.863e-02

It can be seen that midspan deflection is approximately 38.6mm which is less than the deflection with
linear analysis although difference is minute.

As the load is applied, the shape of the plate changes to a curved shape and hence its stiffness also changes.
This change in shape and stiffness is accounted for in the nonlinear simulation. Furthermore, the pressure
loading which is always normal to the plate, starts to have a component in the x-direction as the plate
bends. In a nonlinear analysis, normals to boundaries are updated and pressure load takes the deformation
into account. As a consequence of this, simulation results are different for the linear and nonlinear analysis.
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Now we will plot the membrane force in the plate.
Select SF as output variable in the Field Output toolbar and make sure that SF1 is selected as component.
The simulation results will appear as shown below (Scale factor is set to 2).

SF, SFi

(Avg: 75%)
+1.284e+05
+1.140e+05
+9.960e+04
+8.518e+04
+7.076e+04
+ +5.63424+04
L +4.193e+04
L +2.751e+04
+1.309e+04
-1.327e+03
-1.574e+04
-3.016e+04
-4,458e+04

It can be seen that a significant membrane force has developed in the plate. Initially the plate resists the
pressure load with bending stiffness but after the pressure causes the plate to be curved, the deformed
geometry exhibits additional stiffness and membrane forces appear in the plate. Membrane effects cause
some of the load to be carried by membrane forces rather than by bending alone.

As the load increases on plate, there will be membrane forces in addition to bending moments.

Now we will plot reaction forces at the end nodes where boundary conditions are defined.

Select Symbol as category in the Field Output toolbar.

: ﬂ?’.pfimaf}' EI._U V.-Magnitude v\‘;\

11040

Primary
Deformed

Select RF as output variable and make sure that RESULTANT is selected in component field.

B gymbol v U ] RESULTANT b &
RF

RM

5

SF

SM

u

UR

The simulation results will appear as shown below (Scale factor is set to 2).
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RF, Resultant

+5.411e+02
[ +4.9606+02

+4 5096+02
+4.058e+02
+3.607e+02
+3.1568+02
+2.7056+02
+2.2546+02
+1.804e+02
_ | 11.3530+02
| 15.018e+01
[ +4 509e+01

+0.000e+00

It can be seen that reaction forces develop in all directions on left edge while only in y-direction on the
right edge. It could be related to the fact that the translation of right edge is not constrained in the x-
direction.

The deformation of the plate may be composed of large strains, large translations or large rotations, or
any combination of them. Now we will plot the axial strain in the plate to see if strains are large or small.

Select E as output variable in the Field Output toolbar and make sure that E11 is selected as component.
By default result is plotted for the bottom surface (SNEG) of the shell. We want to plot strain both for
bottom and top surface (SPOS). So pick Result > Section Points from the main menu bar and Sections

Points dialog box will appear.

Select Top and bottom as shown in the figure below.
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Categories

Active locations: () Bottom () Top

Category

shell = ALUMIMUM = = 5 section points  SMEG, (fraction = -1.0)

S Section Points

Selection method: @) Categories () Plies

(® Top and bottom | ) Envelope

i-ﬂp Location
SPOS, (fraction = 1.0)

Bottom Location

To modify the current settings, select one or more locations above:
then select the desired section point below.

oK

Available Section Points in Cross-section

Ap_p-!j,r . .Defaﬁfts ' E.:.i.;aI:.d t}.utput...

C:':I ncel

Pick OK to apply and exit.

The simulation results will appear as shown below (Scale factor is set to 2).

E, E11

SNEG, (fraction
SPOS, (fraction

(Avg: 75%)

+3.769e-03
+3.139e-03
+2.509e-03
+1.879e-03
+1.249e-03
+6.185e-04
-1.159e-05
-6.417e-04
-1.272e-03
-1.902e-03
-2.532e-03
-3.162e-03
-3.792e-03

-1.0)
1.0)

769e-003

It can be seen that maximum absolute axial strain is approximately 0.0038 which is 0.38%. Since the strain
is typically considered small if it is less than 5%, the plate deformation with a strain of 0.38% can be
classified as small strain problem.

Although the deflection of midspan is small compared to the overall dimension of the plate (less than 5%),
still the changes in geometry as the structure deforms have significant influence on the final solution. So it
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can be said that geometric nonlinearity can have considerable influence on the final solution even when
deformation is small.

Select File > Save to save the changes we made so for.

FYTI: The side of shell region in the direction of the positive element normal is called SPOS, while the side
in the direction of the negative element normal is called SNEG.

SPOS

‘. I

T
f |

SNEG Middle surface
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